No part of this manual may be reproduced in any form or by any means (including electronic storage and retrieval or translation into a foreign language) without prior agreement and written consent from Keysight Technologies, Inc. as governed by United States and international copyright laws.

Manual Part Number
54932-97026

Edition
Eighth edition, January 2019

Available in electronic format only
Published by:
Keysight Technologies, Inc.
1900 Garden of the Gods Road
Colorado Springs, CO 80907 USA

Warranty
The material contained in this document is provided “as is,” and is subject to being changed, without notice, in future editions. Further, to the maximum extent permitted by applicable law, Keysight disclaims all warranties, either express or implied, with regard to this manual and any information contained herein, including but not limited to the implied warranties of merchantability and fitness for a particular purpose. Keysight shall not be liable for errors or for incidental or consequential damages in connection with the furnishing, use, or performance of this document or of any information contained herein. Should Keysight and the user have a separate written agreement with warranty terms covering the material in this document that conflict with these terms, the warranty terms in the separate agreement shall control.

Technology Licenses
The hardware and/or software described in this document are furnished under a license and may be used or copied only in accordance with the terms of such license.

U.S. Government Rights
The Software is “commercial computer software,” as defined by Federal Acquisition Regulation (“FAR”) 2.101. Pursuant to FAR 12.212 and 27.405-3 and Department of Defense FAR Supplement (“DFARS”) 227.7202, the U.S. government acquires commercial computer software under the same terms by which the software is customarily provided to the public. Accordingly, Keysight provides the Software to U.S. government customers under its standard commercial license, which is embodied in its End User License Agreement (EULA), a copy of which can be found at http://www.keysight.com/find/sweula. The license set forth in the EULA represents the exclusive authority by which the U.S. government may use, modify, distribute, or disclose the Software. The EULA and the license set forth therein, does not require or permit, among other things, that Keysight: (1) Furnish technical information related to commercial computer software or commercial computer software documentation that is not customarily provided to the public; or (2) Relinquish to, or otherwise provide, the government rights in excess of these rights customarily provided to the public to use, modify, reproduce, release, perform, display, or disclose commercial computer software or commercial computer software documentation. No additional government requirements beyond those set forth in the EULA shall apply, except to the extent that those terms, rights, or licenses are explicitly required from all providers of commercial computer software pursuant to the FAR and the DFARS and are set forth specifically in writing elsewhere in the EULA. Keysight shall be under no obligation to update, revise or otherwise modify the Software. With respect to any technical data as defined by FAR 2.101, pursuant to FAR 12.211 and 27.404.2 and DFARS 227.7102, the U.S. government acquires no greater than Limited Rights as defined in FAR 27.401 or DFAR 227.7103-5 (c), as applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in damage to the product or loss of important data. Do not proceed beyond a CAUTION notice until the indicated conditions are fully understood and met.

WARNING

A WARNING notice denotes a hazard. It calls attention to an operating procedure, practice, or the like that, if not correctly performed or adhered to, could result in personal injury or death. Do not proceed beyond a WARNING notice until the indicated conditions are fully understood and met.
Infiniium Z-Series Oscilloscopes — At a Glance

Table 1  Z-Series oscilloscope bandwidths, sample rates, and memory depths

<table>
<thead>
<tr>
<th>Model</th>
<th>Bandwidth</th>
<th>Sample rate</th>
<th>Memory depth</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>2 channel*</td>
<td>4 channel*</td>
<td>2 channel*</td>
</tr>
<tr>
<td>DSAZ634A</td>
<td>63 GHz</td>
<td>33 GHz</td>
<td>160 GS/s</td>
</tr>
<tr>
<td>DSOZ634A</td>
<td>63 GHz</td>
<td>33 GHz</td>
<td>160 GS/s</td>
</tr>
<tr>
<td>DSAZ504A</td>
<td>50 GHz</td>
<td>33 GHz</td>
<td>160 GS/s</td>
</tr>
<tr>
<td>DSOZ504A</td>
<td>50 GHz</td>
<td>33 GHz</td>
<td>160 GS/s</td>
</tr>
<tr>
<td>DSAZ334A</td>
<td>33 GHz</td>
<td>33 GHz</td>
<td>80 GS/s</td>
</tr>
<tr>
<td>DSOZ334A</td>
<td>33 GHz</td>
<td>33 GHz</td>
<td>80 GS/s</td>
</tr>
<tr>
<td>DSAZ254A</td>
<td>25 GHz</td>
<td>25 GHz</td>
<td>80 GS/s</td>
</tr>
<tr>
<td>DSOZ254A</td>
<td>25 GHz</td>
<td>25 GHz</td>
<td>80 GS/s</td>
</tr>
<tr>
<td>DSAZ204A</td>
<td>20 GHz</td>
<td>20 GHz</td>
<td>80 GS/s</td>
</tr>
<tr>
<td>DSOZ204A</td>
<td>20 GHz</td>
<td>20 GHz</td>
<td>80 GS/s</td>
</tr>
<tr>
<td>DSAZ632A*</td>
<td>63 GHz</td>
<td>33 GHz</td>
<td>160 GS/s</td>
</tr>
<tr>
<td>DSOZ632A*</td>
<td>63 GHz</td>
<td>33 GHz</td>
<td>160 GS/s</td>
</tr>
</tbody>
</table>

* Number of channels for DSOZ/DSAZ632A models are halved.
Ease of use with high performance

The Infiniium Z-Series oscilloscopes combine unprecedented ease of use with high-performance digitizing oscilloscope functionality to simplify your design and analysis measurement tasks.

- Traditional oscilloscope front-panel interface provides direct access to the controls needed for most troubleshooting tasks.
- User interface with menus, windows, dialog boxes, and toolbars provides easy access to dozens of configuration and analysis tools, ensuring you can set up and make the most complex measurements.
- All models offer 80 GSa/s sampling rate on all four channels. RealEdge models offer 160 GSa/s on two channels.
- Models with bandwidths from 20 GHz to 63 GHz.

Display shows waveforms and user interface

- User interface allows direct interaction with waveforms, including drag-and-drop positioning and instant waveform zoom.
- Large capacitive touch screen with multi-touch (gestures), handles, and resizing allows oscilloscope operation without an external pointing device.
- Waveforms are displayed in color, making correlation easy.
- Current configuration parameters displayed near the waveform display area are color-coded to make identification easy.
- Menus and toolbars simplify complex measurement setups.

Acquisition and general controls start and stop the oscilloscope and do basic setup

- Run, stop, and single controls for continuous or single acquisitions.
- Clear display before one or more acquisitions.
- Default setup and Autoscale set initial configuration.

Removable solid-state drive and USB 2.0 and 3.0 ports for saving and restoring setups and measurement results

- Store measurement displays for inclusion in reports and test setup guides.
- Store oscilloscope setups to repeat tests another time.
- Hard disk stores oscilloscope operating system.

Trigger setup controls set mode and basic parameters

- Select Edge, Glitch, or Advanced Modes.
- Choose input source and slope.
- Use auxiliary trigger to increase triggering flexibility.
Vertical controls set attenuation and position
  • Color-coded knobs make it easy to find the controls that affect each waveform.

Marker and quick measurements help measure waveform parameters
  • Use waveform markers to check voltage or Δ-time at any point on the displayed waveform.
In This Guide

This guide provides the information you need to begin using the Infiniium Z-Series oscilloscopes.

Chapter 1, “Setting Up the Oscilloscope,” starting on page 11, includes power and air flow requirements, plus other setup information.

Chapter 2, “Using the Oscilloscope,” starting on page 29, familiarizes you with the inputs and outputs, front-panel controls, and user interface, and describes how to perform basic operations with the oscilloscope.

Chapter 3, “Online Help and Other Information,” starting on page 53, describes the Infiniium oscilloscope application’s online help contents and online demos. The online help describes how to use the Infiniium oscilloscope application in detail.

Appendix A, “For 2-Channel Models,” starting on page 57, provides information unique to the 2-channel Z-Series models.

For More Information

• For detailed information on how the oscilloscope makes measurements and how to use the oscilloscope, see the Infiniium oscilloscope application’s online help. See "Accessing the Online Help" on page 53.

• For information on controlling the oscilloscope from a remote computer, see the Infiniium Oscilloscopes Programmer’s Guide found in the Infiniium oscilloscope application’s online help.

• For information on testing and servicing the oscilloscope, see the Infiniium Z-Series Oscilloscopes Service Guide found in the Infiniium oscilloscope application’s online help.

For more information about Infiniium oscilloscopes, see www.keysight.com/find/scope.
Contents

Infinium Z-Series Oscilloscopes – At a Glance

In This Guide

1 Setting Up the Oscilloscope

Safety / 12
  Safety Compliance / 12
  Acoustic Statement / 12
  General Safety Notices / 12
Symbols / 13
Inspecting Package Contents / 14
Specifications and Characteristics / 15
Ventilation / 16

⚠️ High noise level possibility / 17
  Location / 17
Connecting Accessories and Cables / 18
Connecting Power / 19
  Power supply protection features / 20
Connecting Oscilloscope Probes / 21
Connecting Threaded RF Cables / 22
Tilting the Oscilloscope for Easier Viewing / 22
Turning On the Oscilloscope / 23
Changing the Administrator Password / 23
Verifying Basic Oscilloscope Operation / 24
Installing Application Programs on Infiniium / 25
Changing Windows Operating System Settings / 26
Turning Off the Oscilloscope / 27
Cleaning the Oscilloscope / 27
2 Using the Oscilloscope

Front Panel Inputs and Outputs / 30
  Channel 1-4 inputs / 30
  RealEdge 1R, 3R channel inputs / 30
  Ground / 31
  Aux Out / 31
  Cal Out / 31
  Probe compensation terminal / 31
  USB host ports / 31

Front or Back Panel Inputs and Outputs / 32
  Trig Out / 32
  Aux Trig / 32

Back Panel Inputs and Outputs / 33
  Motherboard I/O / 33
  10 MHz In, 10 MHz Out / 34
  100 MHz In, 100 MHz Out / 34

Front Panel Controls (Keys and Knobs) Overview / 35

User Interface Overview / 36
  Menu overview / 37

Using the Setup and Display Controls / 38
  Using Auto Scale and Default Setup / 38
  Using the Touch Screen / 38
  Clearing the Waveform Display / 38

Starting and Stopping Waveform Acquisitions / 40

Adjusting the Horizontal Settings / 41
  Adjusting the horizontal scale / 41
  Adjusting the horizontal trigger position (delay) / 42
  Magnifying a part of the waveform using Zoom / 42
  Setting the scale, position, and timebase reference / 42

Adjusting the Vertical Settings / 43
  Turning a channel on or off / 44
  Adjusting a channel's vertical settings / 44

Setting Up Triggers / 45
  Setting the Oscilloscope to Trigger on an Edge / 45

Using Markers and Making a Measurement / 47
  Making a measurement on a waveform / 48
  Using Quick Measurements / 48
1 Setting Up the Oscilloscope

Safety 12
Symbols 13
Inspecting Package Contents 14
Specifications and Characteristics 15
Ventilation 16
Connecting Accessories and Cables 18
Connecting Power 19
Connecting Oscilloscope Probes 21
Connecting Threaded RF Cables 22
Tilting the Oscilloscope for Easier Viewing 22
Turning On the Oscilloscope 23
Changing the Administrator Password 23
Verifying Basic Oscilloscope Operation 24
Installing Application Programs on Infiniium 25
Changing Windows Operating System Settings 26
Turning Off the Oscilloscope 27
Cleaning the Oscilloscope 27

This chapter shows how to set up and prepare your Infiniium oscilloscope for first-time use.
Safety

This product has been designed and tested in accordance with accepted industry standards, and has been supplied in a safe condition. The documentation contains information and warnings that must be followed by the user to ensure safe operation and to maintain the product in a safe condition.

Safety Compliance

This product complies with the current editions of the following standards:

- CAN/CSA-C22.2 No. 61010-1-12
- UL Std. No. 61010-1 (3rd edition)

Acoustic Statement

This is to declare that this instrument is in conformance with the German Regulation on Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordnung -3.GSGV Deutschland).

LpA < 70 dB

Operator position

Normal position per ISO 7779

General Safety Notices

**WARNING**

This is a Safety Protection Class I Product (provided with a protective earthing ground incorporated in the power cord). The mains plug shall only be inserted in a socket outlet provided with a protective earth contact. Any interruption of the protective conductor inside or outside of the product is likely to make the product dangerous. Intentional interruption is prohibited.

**WARNING**

If this product is not used as specified, the protection provided by the equipment could be impaired. This product must be used in a normal condition (in which all means for protection are intact) only.

**WARNING**

No operator-serviceable parts inside. Refer servicing to qualified personnel. To prevent electrical shock, do not remove covers.
Symbols

These symbols are used on the Infiniium oscilloscope.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="C-Tick" /> N10149</td>
<td>The C-Tick mark is a registered trademark of the Australian Spectrum Management Agency.</td>
</tr>
<tr>
<td><img src="Image" alt="CE" /></td>
<td>The CE mark is a registered trademark of the European Community.</td>
</tr>
<tr>
<td><img src="Image" alt="ICES/NMB-001 ISM Group 1-A" /></td>
<td>ICES / NMB-001 Cet appareil ISM est conforme a la norme NMB du Canada. This is a marking to indicate product compliance with the Industry Canadian Interference-Causing Equipment Standard (ICES-001). This is also a symbol of an Industrial Scientific and Medical Group 1 Class A product (CISPR 11, Clause 4).</td>
</tr>
<tr>
<td><img src="Image" alt="Separate collection" /></td>
<td>This symbol indicates separate collection for electrical and electronic equipment mandated under EU law as of August 13, 2005. All electric and electronic equipment are required to be separated from normal waste for disposal (Reference WEEE Directive 2002/96/EC).</td>
</tr>
<tr>
<td><img src="Image" alt="40 years" /></td>
<td>Indicates the time period during which no hazardous or toxic substance elements are expected to leak or deteriorate during normal use. Forty years is the expected useful life of the product.</td>
</tr>
<tr>
<td><img src="Image" alt="China standard GB 18455-2001" /></td>
<td>The symbol on all primary and secondary packaging indicates compliance to China standard GB 18455-2001. To return unwanted products, contact your local Keysight office.</td>
</tr>
<tr>
<td><img src="Image" alt="CSA" /></td>
<td>The CSA mark is a registered trademark of the CSA International.</td>
</tr>
</tbody>
</table>
Inspecting Package Contents

✔ Inspect the shipping container for damage.
  - Keep the shipping container or cushioning material until you have inspected the contents of the shipment for completeness and have checked the oscilloscope mechanically and electrically. (It is a good idea to save the shipping box and packaging materials in case you ever need to send the oscilloscope to Keysight for repair or calibration.)
  - If the shipping container is damaged, or the cushioning materials show signs of stress, notify the carrier and your Keysight Technologies Sales Office. Keep the shipping materials for the carrier's inspection. The Keysight Technologies Sales Office will arrange for repair or replacement at Keysight's option without waiting for claim settlement.

✔ Inspect the oscilloscope.
If there is mechanical damage or a defect, or if the oscilloscope does not operate properly or does not pass performance tests, notify your Keysight Technologies Sales Office.

✔ Verify that you received the following items in the Infinium oscilloscope packaging.
  - Infinium oscilloscope
  - power cord
  - keyboard
  - mouse (USB optical)
  - front panel cover
  - calibration cable (the 50 GHz and 63 GHz bandwidth models include a second calibration cable for the RealEdge inputs)
  - connector savers (quantity of 5 for 20 GHz, 25 GHz, and 33 GHz bandwidth models; additional 2 for 50 GHz and 63 GHz bandwidth models)
  - ESD wrist strap
  - Quick Start poster

If anything is missing, contact your nearest Keysight Technologies Sales Office.

✔ Verify that you received the options and accessories you ordered and that none were damaged.
For a complete list of options and accessories available for the Z-Series oscilloscopes, see the Infinium Z-Series Oscilloscopes Data Sheet.
## Specifications and Characteristics

**Table 2  Z-Series oscilloscope specifications and characteristics**

<table>
<thead>
<tr>
<th>Environment</th>
<th>Indoor use only</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ambient Temperature</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>+5 °C to +40 °C</td>
</tr>
<tr>
<td>Non-operating</td>
<td>+40 °C to +65 °C</td>
</tr>
<tr>
<td><strong>Humidity</strong></td>
<td></td>
</tr>
<tr>
<td>Operating (non-condensing)</td>
<td>+40 °C</td>
</tr>
<tr>
<td>Non-operating</td>
<td>up to 95% relative humidity at +65 °C</td>
</tr>
<tr>
<td><strong>Altitude</strong></td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>up to 4,000 meters (12,000 feet)</td>
</tr>
<tr>
<td>Non-operating</td>
<td>up to 15,300 meters (50,000 feet)</td>
</tr>
<tr>
<td><strong>Installation Category</strong></td>
<td>II</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>32.3 kg (71 lbs)</td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>50.8 cm wide (20 in), 33.8 cm tall (13.3 in), and 49.3 cm deep (19.4 in)</td>
</tr>
<tr>
<td><strong>Safety</strong></td>
<td>CAN/CSA-C22.2 No. 61010-1-12</td>
</tr>
<tr>
<td></td>
<td>UL Std. No. 61010-1 (3rd Edition)</td>
</tr>
<tr>
<td><strong>Voltage Fluctuations</strong></td>
<td>The mains supply voltage fluctuations are not to exceed ±10% of the nominal supply voltage.</td>
</tr>
<tr>
<td><strong>Pollution Degree</strong></td>
<td>The Infiniium Z-Series oscilloscopes may be operated in environments of Pollution Degree 2.</td>
</tr>
</tbody>
</table>

### Pollution Degree Definitions

<table>
<thead>
<tr>
<th>Pollution Degree Definitions</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pollution Degree 1:</td>
<td>No pollution or only dry, non-conductive pollution occurs. The pollution has no influence. Example: A clean room or climate controlled office environment.</td>
</tr>
<tr>
<td>Pollution Degree 2:</td>
<td>Normally only dry non-conductive pollution occurs. Occasionally a temporary conductivity caused by condensation may occur. Example: General indoor environment.</td>
</tr>
<tr>
<td>Pollution Degree 3:</td>
<td>Conductive pollution occurs, or dry, non-conductive pollution occurs which becomes conductive due to condensation which is expected. Example: Sheltered outdoor environment.</td>
</tr>
</tbody>
</table>

**NOTE**

The Infiniium Z-Series oscilloscopes are very heavy and awkward for a single individual to move. It is highly recommended that two people or a mechanical lift be used to transport the oscilloscope.
Ventilation

Position the oscilloscope where it will have sufficient clearance for airflow around the back and sides. If you plan to connect multiple Infiniium oscilloscopes together, refer to the Keysight MultiScope Hardware Configuration Guide for airflow requirements.

**CAUTION**

VENTILATION REQUIREMENTS: When installing the instrument(s) into a cabinet, consider the convection flow into and out of the cabinet. Also consider the individual instruments, to avoid having the heated discharge of one instrument become the cooling intake air for another instrument.
Location

Install the oscilloscope so that the detachable power cord is readily identifiable and is easily reached by the operator.

The detachable power cord is the oscilloscope disconnecting device. It disconnects the mains circuits from the mains supply before other parts of the oscilloscope. (The front panel switch is only a standby switch and is not a LINE switch.)

Alternatively, an externally installed switch or circuit breaker (which is readily identifiable and is easily reached by the operator) may be used as a disconnecting device.

⚠️ High noise level possibility

The Z-Series oscilloscopes use six cooling fans, located on the left side of the oscilloscope. The fan speed is based on the ambient temperature as sensed by a circuit inside the oscilloscope. In a typical work environment where a user is operating the oscilloscope, the facility air temperature will be approximately 22 to 24 °C. Under these conditions the fans will produce a noise level of 53.5 dB at the front of the instrument and a slightly higher noise level on the fan side.

As the facility temperature increases, and reaches the maximum ambient of 40 °C for the instrument, the fan will likely reach maximum speed. Under these conditions the noise level could reach approximately 70 dB at the front and slightly higher on the fan side. Note that the high ambient temperature condition would not be typical and may affect user exposure time. These noise levels are considerably lower than the published limits of 80 dB for exposure duration of 24 hours.
Connecting Accessories and Cables

A mouse and keyboard can be plugged into the USB host ports. Four host ports are on the rear panel, with two more on the front panel.

Connect your LAN cable to the RJ-45 connector on the back panel of the oscilloscope.

**NOTE**

After you have connected to the LAN card, you must set up the network. Exit the oscilloscope application before you start setting up your network.

---

**Figure 2** Back panel
Connecting Power

**Table 3  Power requirements**

<table>
<thead>
<tr>
<th>Power</th>
<th>100 to 240 VAC at 50/60 Hz</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum input power: 1350 Watts</td>
<td></td>
</tr>
<tr>
<td>Well-regulated power is required</td>
<td></td>
</tr>
<tr>
<td>for 100-120 VAC operation</td>
<td></td>
</tr>
</tbody>
</table>

- Connect the power cord to the rear of the oscilloscope, then to a suitable AC voltage source.

**WARNING**

Do not use extension cords or power strips.

The use of these devices may lower the AC voltage below the required range and become a safety hazard.

**CAUTION**

Use Supplied Power Cord.

The power cord provided is matched to the country of origin of the order.

**WARNING**

The AC voltage source (outlet) must be in good repair and provide a secure electrical connection.

Do not use the outlet if the power cord plug makes a loose connection with it, or if the power cord plug does not match the outlet. Do not use the outlet if it is damaged or if the outlet voltage is outside the required range.

**WARNING**

Properly ground the oscilloscope to avoid electric shock.

**NOTE**

The oscilloscope’s power supply has a built-in safety feature that, after the oscilloscope is turned off, requires the oscilloscope to remain off for about 10 seconds before it is turned back on.

**CAUTION**

The Mains wiring and connectors must be compatible with the connector used in the premise electrical system. Failure to ensure adequate earth grounding by not using the correct components may cause product damage and serious injury.
This oscilloscope has autoranging line voltage input. Before switching on the oscilloscope, be sure the supply voltage is within the specified range and voltage fluctuations do not exceed 10% of the nominal supply voltage.

Power supply protection features

The Z-Series oscilloscope’s power supply has built-in protection features for over-voltage, over-current, and over-temperature fault conditions. Figure 2 on page 18 identifies the power supply LEDs and Table 4 below describes their conditions.

Table 4  Power supply LED meanings

<table>
<thead>
<tr>
<th>AC LED</th>
<th>DC/FLT (Fault) LED</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Green</td>
<td>Normal operation</td>
</tr>
<tr>
<td>Off</td>
<td>Red</td>
<td>Low or NO AC</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>Over-Voltage Protection</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>Over Current</td>
</tr>
<tr>
<td>Green</td>
<td>Orange</td>
<td>Thermo Alarm Warning</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>Fault Over-Temp</td>
</tr>
<tr>
<td>Green</td>
<td>Red</td>
<td>Remote On/Off</td>
</tr>
</tbody>
</table>

When the over-voltage fault occurs (and the power supply shuts down), you must unplug the power cord, wait 30 seconds, and plug the power cord back in to reset the protection latch and allow the oscilloscope to be powered-on again.

When the over-temperature fault occurs, the temperature must drop below 110 °C before you can power-on the oscilloscope again.
Connecting Oscilloscope Probes

**CAUTION**

**Maximum Input Voltage**

Do not exceed the maximum input voltage rating.

Oscilloscope channels 1-4, 1R, and 3R are rated for maximum input of ± 5V.

The Infiniium Z-Series oscilloscope channel 1-4 inputs have:

- 3.5 mm threaded RF connectors (like Keysight sampling oscilloscopes) to ensure the most reliable signal integrity.
- A convenient automatic torque mechanism that ensures a consistent 8 in-lbs connection.
- An AutoProbe II interface connector with pins that provide probe power, identification, and other communication signals.

![Z-Series oscilloscope probe connectors](image)

Figure 3   Z-Series oscilloscope probe connectors

The AutoProbe II interface works with the InfiniiMax III probing system. There are four different InfiniiMax III probe amplifiers ranging from 16 to 30 GHz. For more information, see Keysight InfiniiMax III/III+ Probing System Data Sheet.

Before using the InfiniiMax III probes, review the InfiniiMax III Probe Handling Guide included with the probes. These probes are ESD sensitive devices and there is a proper order for connecting probe amplifiers to the oscilloscope, probe heads to the device under test (DUT), and probe heads to the amplifier. You can also find the InfiniiMax III Probe Handling Guide on the Keysight web site (www.keysight.com) or with other Keysight oscilloscope probes documentation in the Probe Resource Center (www.keysight.com/find/prc).

The N5442A 3.5 mm to precision BNC adapter lets you use an InfiniiMax I or II active probe with the Z-Series oscilloscopes.
Connecting Threaded RF Cables

You can connect threaded RF cables to the Infiniium Z-Series oscilloscope inputs. For input channels 1 through 4, you can connect 3.5 mm threaded RF cables using the automatic torque “clutch” mechanism to ensure a consistent 8 in-lbs connection.

The **Aux Out** and **Cal Out** connectors also work with 3.5 mm threaded RF cables.

For RealEdge input channels 1R and 3R (on the 50 GHz and 63 GHz bandwidth models), you can connect 1.85 mm threaded RF cables using a torque wrench to apply the necessary 8 in-lbs of torque.

Tilting the Oscilloscope for Easier Viewing

Tabs under the front feet of the oscilloscope can be flipped out to tilt the oscilloscope.

![Flip-out tabs under front feet](Image)
Turning On the Oscilloscope

- To turn on the oscilloscope, press the power/standby switch in the lower left corner of the oscilloscope front panel.

![Power/standby switch](image)

**Figure 5** Turning On the oscilloscope

After a short initialization period, the oscilloscope display appears. The oscilloscope is ready to use.

- You can connect and disconnect probes and cables while the oscilloscope is turned on.

Changing the Administrator Password

On Keysight Infiniium real-time oscilloscopes with the Windows 10 operating system, the default Administrator user account password is "Keysight". Change the Administrator password to something more secure (and less well-known).
Verifying Basic Oscilloscope Operation

1 Install the supplied connector savers to each channel input. Keysight recommends using the connector savers to protect the input connectors.

2 Connect one end of the calibration cable to oscilloscope input channel 1.

3 Connect the other end of the cable to the **Cal Out** connector on the front panel.

4 Press **[Default Setup]** on the front panel.

   The display will pause momentarily while the oscilloscope is configured to its default settings. The oscilloscope is now in a known operating condition.

5 Press **[Auto Scale]** on the front panel.

   The display will pause momentarily while the oscilloscope adjusts the time/div setting and vertical scale so the oscilloscope can best display the input signals. You should then see a square wave with about four cycles on screen and a peak-to-peak amplitude of approximately five divisions.

   If you do not see the waveform, make sure your power source is adequate, the oscilloscope is properly powered on, and the cable is connected securely to the channel input and the calibration output.

![Calibration Cable (54916-61626)](Figure 6) Verifying basic oscilloscope operation
6 Move the mouse around the mouse surface and verify that the on-screen pointer follows the mouse movement.

7 Press the [Touch] key on the front panel to turn on the touch screen. Press and hold your finger to the screen. A right-click menu appears, which verifies that the touch screen is working properly.

Installing Application Programs on Infiniium

Infiniium has an open Windows operating system, which lets you install your own application software. Any application that runs on Microsoft Windows 10 and uses 8 GB of RAM or less may be installed on your Infiniium oscilloscope.

**NOTE**
Exit the Infiniium oscilloscope application before installing any software.

**CAUTION**
Installing an application that does not meet these requirements may break the Infiniium oscilloscope application and require a hard drive recovery.
Changing Windows Operating System Settings

**NOTE** Exit the oscilloscope application before changing any Windows operating system settings outside of the Infiniium oscilloscope application.

Many Windows operating system settings can be changed to suit your own personal preferences. However, some operating system settings should not be changed because doing so would interfere with the proper operation of the oscilloscope.

- Do not change the Power Options.
- Do not change the Language settings.
- Do not remove Fonts.
- Do not change the screen resolution from 1024 by 768 pixels.
- Do not use the Administrative Tools to enable or disable Internet Information Services (IIS) Manager. Use the Infiniium Remote Setup dialog box (**Utilities > Remote...**) to enable or disable the Web (HTTP) Server.
- Do not delete or modify the Infiniium Administrator user account.
Turning Off the Oscilloscope

To turn the oscilloscope off, press the power/standby switch . The oscilloscope will go through a normal Windows operating system shutdown process.

Cleaning the Oscilloscope

**WARNING**

To prevent electrical shock, disconnect the Infiniium oscilloscope from mains before cleaning.

Clean the Infiniium oscilloscope with a soft dry cloth or one slightly dampened with a mild soap and water solution to clean the external case parts. Do not attempt to clean internally.

**CAUTION**

Do not use too much liquid in cleaning the oscilloscope. Water can enter the Infiniium panels, damaging sensitive electronic components.

To avoid electrostatic discharge (ESD), wear a grounded wrist strap when cleaning connectors.

**WARNING**

Use alcohol to clean connectors. The power cord must be removed, and the oscilloscope must be in a well-ventilated area. Allow all residual alcohol moisture to evaporate, and the fumes to dissipate prior to powering up the oscilloscope.
1 Setting Up the Oscilloscope
2 Using the Oscilloscope

This chapter describes how to use the Infiniium Z-Series oscilloscope’s inputs and outputs, front panel controls, and user interface.

- The familiar front-panel oscilloscope interface with knobs and keys is optimized for common tasks and basic measurements.
- With the user interface for the Infinium with menus, windows, dialog boxes, and toolbars provides easy logical access to dozens of configuration and analysis tools, making it easy for you to set up and make complex measurements.
- You have the option of using either the front panel controls or the user interface for many common tasks.
Front Panel Inputs and Outputs

On the Infiniium Z-Series oscilloscopes, the channel inputs and the **Aux Out** and **Cal Out** outputs appear on the lower part of the front panel. The ground plug, probe compensation terminal, and two USB host ports are also located here.

![Infiniium Z-Series oscilloscope front panel I/O](Figure 7)

**Figure 7  Infiniium Z-Series oscilloscope front panel I/O**

Channel 1-4 inputs

The channel 1-4 inputs have:

- 3.5 mm threaded RF connectors
- A convenient automatic torque mechanism
- An AutoProbe II interface connector with pins that provide probe power, identification, and other communication signals

The AutoProbe II interface works with the InfiniiMax III probing system. See “Connecting Oscilloscope Probes” on page 21.

You can also connect 3.5 mm threaded RF cables to the channel 1-4 inputs.

RealEdge 1R, 3R channel inputs

The [RealEdge] key and 1R and 3R channel inputs appear on models > 33 GHz bandwidth.

Pressing the [RealEdge] key enables or disables the RealEdge 1R and 3R channel inputs. The [RealEdge] key is lit when enabled.

![RealEdge channel inputs and [RealEdge] key](Figure 8)

**Figure 8  RealEdge channel inputs and [RealEdge] key**
When enabled, the RealEdge 1R and 3R channel inputs take over the standard channels 1–4, except for the trigger circuitry on channels 2 and 4. When RealEdge is enabled, you can still trigger on signals connected to the channel 2 and 4 inputs (but you cannot capture or display data from these signals).

You can connect 1.85 mm threaded RF cables to the RealEdge 1R and 3R channel inputs.

**Ground**

The ground plug is convenient for ESD wrist straps.

**Aux Out**

This output signal is selected by the Infiniium oscilloscope application's Calibration Output dialog box (Utilities > Calibration Output...). It can be a DC level, the probe compensation signal (a square wave used to adjust compensated passive probes), the trigger out signal, or a demo signal.

**Cal Out**

This calibration output is used when performing a user calibration on the oscilloscope.

A calibration cable is included with the oscilloscope. Models > 33 GHz bandwidth include a second calibration cable for the RealEdge channel inputs.

You can also use the Infiniium oscilloscope application's Calibration Output dialog box (Utilities > Calibration Output...) to select other output signals, just like you can for the Aux Out output.

**Probe compensation terminal**

This terminal has a square wave signal that is used to adjust compensated passive probes.

You can also output a DC level on this terminal using the Infiniium oscilloscope application's Calibration Output dialog box.

**USB host ports**

Two USB host ports are located on the front panel, next to the power/standby switch.
Front or Back Panel Inputs and Outputs

Trig Out and Aux Trig appear on the back panel in 50 GHz and 63 GHz bandwidth models of Z-Series oscilloscopes, and on models that have the optional sync port. They appear on the front panel in 20 GHz, 25 GHz, and 33 GHz bandwidth models.

Trig Out

Pulses corresponding to oscilloscope triggers can be sent to this BNC output.

Aux Trig

You can set up the oscilloscope to trigger on the auxiliary trigger signal connected to this BNC input.
Back Panel Inputs and Outputs

The Infiniium Z-Series oscilloscope’s back panel has the motherboard I/O connectors and reference clock synchronization connectors.

Figure 9  Infiniium Z-Series oscilloscope back panel I/O

Motherboard I/O

The motherboard provides these inputs/outputs/ports in the oscilloscope: four USB ports for peripherals, an external monitor connector, USB III device port (for remote control of the oscilloscope from a PC), LAN port, and speaker and microphone connectors.
10 MHz In, 10 MHz Out

The 10 MHz In BNC connector is used to synchronize the oscilloscope’s horizontal timebase system to a reference clock that you provide. The clock that you provide must meet the following specifications:

- Amplitude: 178 mV peak to 1 V peak
- Frequency: 10 MHz ±5 ppm high-quality sine wave or square wave

To use a 10 MHz external reference clock, connect the external clock to the 10 MHz In BNC connector; then, in the Infiniium oscilloscope application’s Horizontal dialog box (Setup > Horizontal…), enable the 10 MHz External Reference Clock.

You can use the 10 MHz Out BNC connector to send the oscilloscope’s 10 MHz reference clock output signal to another instrument’s reference clock input.

100 MHz In, 100 MHz Out

The 100 MHz IN SMA connector is used to synchronize the oscilloscope’s horizontal timebase system to a reference clock that you provide. The clock you provide must meet the following specifications:

- Amplitude: 178 mV peak to 1 V peak
- Frequency: 100 MHz ±5 ppm high-quality sine wave or square wave

To use a 100 MHz external reference clock, connect the external clock to the 100 MHz In SMA connector; then, in the Infiniium oscilloscope application’s Horizontal dialog box (Setup > Horizontal…), enable the 100 MHz External Reference Clock.

You can use the 100 MHz Out SMA connector to send the oscilloscope’s 100 MHz reference clock output signal to another instrument’s reference clock input.
Front Panel Controls (Keys and Knobs) Overview

The Infiniium Z-Series oscilloscope front panel gives you direct access to the functions needed to perform the most common measurements, using a traditional oscilloscope interface. Knobs and keys let you directly set vertical and horizontal parameters. The front panel also has a set of LED indicators; by using these and the display, you see the oscilloscope’s configuration at a glance.

The oscilloscope uses color consistently throughout the front panel and user interface. For example, the color of the knob for channel 1 is the same color as the waveform for channel 1. All the configuration items and values related to channel 1 are displayed in the same color.

Figure 10  Infiniium Z-Series oscilloscope front panel
User Interface Overview

With the user interface for the Infiniium oscilloscope, you can access all the configuration and measurement features of the oscilloscope through an easy-to-use system of windows, menus, toolbars, dialog boxes, icons, wizards, and buttons.

The user interface is arranged so the most common functions affecting the waveform display are located around the edge of the waveform display area.

Context-sensitive menus are available when you right-click something in the waveform display area, such as the grid, a signal, a bookmark, or a measurement. You can mouse over or touch other areas, such as the drag & drop measurements area and horizontal and acquisition control regions, to find more information about those areas or to enter data.

Figure 11 calls out the areas and controls of the user interface.

![Figure 11: Infiniium oscilloscope display](image)
The selected grid mode in the upper right corner determines whether you draw a selection box or manipulate waveforms when you touch the screen.

The waveform display area shows up to eight waveform windows. Several display options are available, such as grids or horizontal and vertical scales.

**NOTE**

**Avoid Overdriving Vertical Input Amplifiers**

When zooming on a waveform with the oscilloscope running, be careful to keep the signal within the screen vertically to avoid overdriving the vertical input amplifiers. Overdriving causes waveform distortion and erroneous measurement results.

Ground reference indicators appear for each displayed channel, waveform memory, or math function waveform. The symbol represents the ground reference point for each waveform; it moves when you change the vertical offset. You can also drag this symbol up and down to change the vertical offset for that waveform.

A Results pane is visible at the very bottom of the display when you do something that requires it, such as take a measurement. When it is not needed, the Results pane is not visible.

![Figure 12  Results pane](image)

**Menu overview**

Use menus to perform defined operations and access every function the oscilloscope provides.

Take a few minutes to look through the menus to get an overview of the many features and capabilities of your Infiniium oscilloscope. The sub-menu selections will vary slightly, depending on which licenses are installed.
Using the Setup and Display Controls

With the setup and display controls you can quickly get a stable waveform display, enable or disable the touch screen, clear the display, and set the oscilloscope to a known starting condition.

Using Auto Scale and Default Setup

To automatically configure the oscilloscope to best display the current input signal(s), press [Auto Scale] or choose Control > Autoscale. The oscilloscope will determine which channels have activity, then turn these channels on and scale them.

To reset the oscilloscope to its default setup, press [Default Setup]. To undo a default setup, use the Undo button.

NOTE

Save the Current Oscilloscope Configuration

Before using the default setup, you may want to save the current oscilloscope configuration for later use. See the online help (described in Chapter 3) for instructions on saving setups, and for information on the exact configuration that is set when you use the default setup.

Using the Touch Screen

1. To enable the touch screen so it responds to multi-touch gestures, similar to those used on tablets and smart phones, press [Touch] or choose Utilities > User Preferences... and select the Enable Touch Screen check box.

2. Touch the drag waveform icon to highlight it.

Now you can use gestures to flick items horizontally, drag a waveform vertically, drag horizontally to change the horizontal delay, pinch horizontally to adjust time/div and delay settings, pinch vertically to adjust a waveform’s V/div and offset settings, or tap to select waveforms and other selections on the display.

Clearing the Waveform Display

When you press [Clear Display] or click , the oscilloscope clears acquired waveform data from the display in preparation for another acquisition. If the oscilloscope is in Run mode and is receiving triggers, it will update the display as it collects new waveform data.
Clearing the waveform display also resets averaging, infinite persistence, color grade persistence, histograms, measurement statistics, and the mask testing database.
Starting and Stopping Waveform Acquisitions

To run and stop acquisitions or make a single acquisition, use the acquisition run controls. The boxed area of the memory bar shows which portion of the channel’s acquisition memory you are viewing.

- To start waveform acquisition, press [Run/Stop] or click Run.
  The oscilloscope begins acquiring data. When it receives a trigger signal, it finishes acquiring data, updates the display, and then starts another acquisition cycle if it is in Trig’d or Auto trigger mode.
- To stop waveform acquisition, press [Run/Stop] or click Stop. Data that was last acquired remains on the screen.
- To make a single acquisition, press [Single] or click Single.
- You can also choose the Run, Run Single, and Stop commands from the Control menu.
- To set up how you want the signals to be sampled, such as sampling rate and mode, choose Setup > Acquisition....
Adjusting the Horizontal Settings

To configure the horizontal scale (time per division) and horizontal position of the waveform, use the horizontal controls. You can view a magnified section of the waveform using the zoom window.

To adjust the horizontal scale and position, use gestures on the touch screen or use the horizontal knobs, horizontal controls, or Horizontal dialog box.

Adjusting the horizontal scale

- The horizontal scale knob is the larger of the two horizontal control knobs. To stretch the waveform horizontally (displaying fewer seconds per division), turn the knob clockwise. To shrink it horizontally, turn the knob counter-clockwise.
- Push and turn the horizontal scale knob to change the scaling in finer (Vernier) increments.
- You can also use multi-touch gestures to stretch or shrink the waveform.
- To adjust the horizontal scale using the controls in the horizontal toolbar, mouse over or touch the horizontal scale field and use the resulting controls to set a particular horizontal scale. Click the Scale field to enter an exact value, or click the “narrower” or “wider” buttons.

Figure 15  Horizontal knobs, [Zoom] key, user interface controls
Adjusting the horizontal trigger position (delay)

- The horizontal position knob is the smaller of the two horizontal control knobs. Turn it to move the waveform to the right or left.

Moving the waveform to the right shows more of the pre-trigger data (data acquired before the trigger event). Moving it to the left shows more post-trigger data.

When you drag a waveform, the horizontal position changes for all channels and functions on the display. Waveform memories will also move if you select the **Tie to Timebase** check box in the Waveform Memories dialog box.

- To adjust the horizontal position using the controls in the horizontal toolbar, mouse over or touch the horizontal position field and use the resulting controls to set a particular horizontal position (time relative to the trigger at the highlighted horizontal reference point).

Magnifying a part of the waveform using Zoom

- To turn on zoom, press the **Zoom** key or click the Zoom button.

The waveform display area splits into two regions. The top one is the main timebase. The bottom is the zoomed timebase, which represents an expansion of the acquired waveform data. A section of the waveform in the main timebase window is highlighted to indicate the part shown in the zoomed timebase window.

The horizontal scale and position controls now change how the waveform is shown in the zoomed timebase window. The horizontal scale will change the amount of magnification, while the position will change the part of the waveform in the main window that is shown in the zoomed window.

- To turn off zoom, press **Zoom** or click again.

Setting the scale, position, and timebase reference

To set scale, position, and timebase reference, use the Horizontal dialog box or set up the zoomed timebase window.

To access the Horizontal dialog box, click the **Horizontal** in the horizontal toolbar or choose **Setup > Horizontal...** from the main menu.

The Timebase Reference ranges from 0 to 100% of the screen. The center of the screen is at 50%. The slider correlates to the hollow orange triangle at the bottom of the display area, showing where the horizontal offset is on the screen.
Adjusting the Vertical Settings

Use the vertical controls to set the vertical scaling (volts per division) and vertical offset. You can also turn the display on or off for a specific channel.

**Figure 16** Channel keys and vertical scale and offset knobs

**Figure 17** User interface vertical controls
Turning a channel on or off

- To turn channels 1 through 4 on or off, press the channel number key on the front panel or click the Add Waveforms button +. When you turn off a channel, the current vertical scale and offset fields for that channel disappear.
- To change from 33 GHz inputs to 63 GHz inputs, press the RealEdge key on the front panel. Channels 1 and 3 become 1R and 3R. Channels 2 and 4 are not used in RealEdge mode.
- If you are not using a particular channel, you can turn it off to simplify the waveform display and increase the display update rate. Functions continue to run on a channel source that is turned off. Data acquisition continues for a channel if a function requires it.

Using a Channel as Trigger

Any channel can be used as a trigger source. If you need a trigger but do not need all channels, you can use a channel as a trigger without displaying it by turning the channel display off.

Adjusting a channel’s vertical settings

To adjust the vertical scale and offset, use the vertical scale and offset knobs, vertical user interface controls, or Channel dialog box.

The vertical scale knob is the larger of the two knobs for a channel. Turn it to make the waveform bigger (fewer volts per division) or smaller. You can also mouse over or touch the vertical scale field and use the resulting controls to set an exact value for the scaling.

The vertical offset knob is the smaller knob for a channel. Turn it to move the waveform up or down.

You can drag the waveform or its ground reference indicator to the desired vertical offset if the grid is in drag mode.

Click Setup > Channel N... or click a channel number to open the Channel dialog box, in which you can set the vertical scale, offset, skew, and labels.
Setting Up Triggers

Use the trigger controls to set the conditions on which the oscilloscope will trigger and acquire an input signal. You can set up a variety of trigger conditions. Edge triggers and the parameters for edge triggering can be set up from the front panel.

Trigger configuration settings you make using the user interface are reflected in the front-panel Trigger status indicators, and will remain set unless you change them or press [Default Setup].

![Trigger controls and indicators](image)

**Figure 18** Trigger controls and indicators

Setting the Oscilloscope to Trigger on an Edge

1. Press [Source] until the desired trigger source LED is lit.
   
   You can choose any channel or the Aux Trig or Line input as the source for an edge trigger.

2. Press [Slope] until the desired slope LED is lit.
   
   You can have an edge trigger on a rising or falling edge, or both.

3. Press [Sweep] until the desired LED is lit (Trig’d or Auto).
   
   When Trig’d is selected, the oscilloscope must find the trigger before saving and displaying captured data.

   When Auto is selected, an acquisition is automatically saved and displayed if a trigger does not occur within a certain amount of time. In Auto trigger mode, you are able to see your signals while setting up the desired trigger.

4. Turn the Level knob to adjust the voltage level at which the oscilloscope will trigger. Push the knob to set the level to the middle of the waveform.
Use the Trigger dialog box to select any of the modes of triggering, the parameters and conditions for each trigger mode, and advanced configuration items.

You can also mouse over the Trigger Level field and use the resulting controls to set a particular trigger level when the oscilloscope is set for edge triggering on a particular channel. Likewise, you can drag the trigger reference indicator at the left side of the display or drag the trigger line itself, which appears when you click or touch the grid.
Using Markers and Making a Measurement

Use the measurement/markers controls to display and adjust markers, define a key to perform automatic measurements or other quick actions, and make measurements.

**Figure 19** Measure controls

**Figure 20** Drag & Drop measurement toolbar
Making a measurement on a waveform

To make a measurement, either drag a measurement icon to the waveform event you want to measure, or click a measurement icon and use the resulting dialog box to specify which source you want to measure.

For measurements on waveform features, such as those that involve waveform edges, if you click the measurement icon and specify a source, the measurement defaults to using the feature closest to the horizontal reference point. If you make the measurement using drag & drop, the measurement uses the waveform feature closest to the point where you drop the icon.

The most commonly used measurements are available in the drag & drop area. Others are available from the Add Measurement dialog box (Measure/Mark > Add Measurement...).

When you drag and drop a measurement icon on a waveform, the icon outline changes color to match the color of each waveform it touches so you can easily see which waveform will be measured.

For edge-sensitive measurements, a circled number appears in the waveform marker color when you drop the measurement icon on a waveform. This number shows exactly where the measurement is being made. It appears next to the measurement readout in the Results pane. This feature helps you distinguish measurement results from each other when you make multiple measurements on the same waveform, but at different waveform features.

Using Quick Measurements

You can define the [Multi Purpose] key to perform one of many quick actions, such as loading a setup file, saving composite data or a measurement report to a file, saving the screen image to a bitmap file, or performing automatic measurements.

The action taken when [Multi Purpose] is pressed (or Utilities > Multipurpose is chosen) depends on the feature selected in the Customize Multipurpose dialog box (Utilities > Customize Multipurpose...). The default feature is QuickMeas.

- To turn on the quick measurement display, press [Multi Purpose]. The 10 preset measurements defined in the Quick Measurement configuration are enabled and results are displayed on the screen for the first waveform source.
- To measure parameters for another waveform, press [Multi Purpose] until that waveform is the one shown in the measurement readout. Continuing to press [Multi Purpose] cycles through each of the waveforms available.
- To turn off the quick measurement display, cycle through all channels until the measurements are turned off.

See the Infiniium oscilloscope application's online help for information on how to configure the quick measurement capability.
Using Markers

Markers make it easier to make precise measurements because the marker measurement readouts show exact voltage and time positions for the markers. The measurements are based on actual waveform data from the acquisition system, not on approximations based on the display position, so you can be sure the values are highly accurate.

Using the marker and measurement controls, you can control multiple sets of markers within the oscilloscope grid.

Both time and voltage differences between the markers are updated continuously on the screen. By default, the markers track the source waveform. Voltage measurements from the markers are the value of the waveform at the time set with the marker arrow keys.

- To add markers, press the [Markers] key or click the Markers button , then select the sources and mode in the Add Marker dialog box. Notice the drawing in the Description area of the dialog box.
- To move a marker, click and drag it or turn the horizontal or vertical Position knob. Push the knob to select the next marker.
- Marker 1 has a solid line pattern on the waveform display. It is associated with the first available source on the display.
- You can use the front panel Position knobs for fine adjustment, or use the Add Marker dialog box to set the marker position precisely.
Saving and Printing Data

- Click **File > Save** to save your composite, setup, waveform, screen image, or measurement data. You can also save to a waveform memory.
- Click **File > Copy Screen Image** to easily copy and paste a screen image into a document.
- Click **File > Print...** to print waveform and setup data to a specified file.
- You can customize the [Multi Purpose] key to perform certain actions such as a QuickPrint very quickly.
Forcing a Default Setup

If your Infiniium oscilloscope is not working properly when you start it up, follow these steps to perform a default setup and return the Infiniium application to normal operation.

1. Choose Control > Default Setup or press [Default Setup].
2. If the oscilloscope is still not working properly, choose Control > Factory Default to return the oscilloscope to the default settings it had when it left the factory.
3. If the oscilloscope is still not working properly, turn it off.
4. Turn the oscilloscope back on. If it does not successfully restart, try recycling the power again.
5. As soon as the Windows load screen disappears, press [Default Setup]. If the oscilloscope still does not successfully restart, follow the instructions for recovering the hard drive.

Infiniium Hard Drive Recovery

Follow these steps to recover your Infiniium hard drive.

1. Back up your cal and license files if they are still accessible:
   a. If the Infiniium application is available, launch the Keysight License Manager (Utilities > Launch License Manager...) and capture a screen shot of the page. It lists the transportable and fixed perpetual licenses that Keysight will need to reissue.
   b. Copy the calibration folder (C:\ProgramData\Infiniium\cal) to an external device, such as a flash drive.
   c. Copy the license file (C:\ProgramData\Infiniium\license.dat), which contains legacy licenses, to an external device.
2. Turn off the oscilloscope.
3. Make sure a keyboard and mouse are connected to the USB host ports.
4. Turn on the oscilloscope and watch closely for the system prompts. As soon as you see the prompt to choose Microsoft Windows or Instrument Image Recovery System, select Instrument Image Recovery System and follow the on-screen instructions.
5. Once the recovery process is finished and the oscilloscope is running, check in the About Infiniium dialog box under installed options to see if all of the options you ordered are installed. If the options are not installed, install them using the license keys provided on the oscilloscope option license certificates you received, or refer to the back of the oscilloscope.
6. Restore the calibration folder and license files back to their original locations.
7. Restart the oscilloscope application to ensure the license.dat file reflects any factory bandwidth licenses.
8 Send an email message to csg.support@keysight.com. Provide the License Manager screen shot page you captured earlier, the oscilloscope’s model and serial number from the rear panel of the scope, and the zip file you created earlier.

9 From the oscilloscope desktop, launch the Infiniium application. When the application is active, perform a scope self-test (Utilities > Self Test...).
3 Online Help and Other Information

Accessing the Online Help 53
Navigating the Online Help 54
Using the Demo Wizard 55

Almost anything you want to know about the Infinium oscilloscope is available in the online help.

Accessing the Online Help

There are two ways to access the online help:

- Click the question mark near the top right corner of a dialog box to open the help topic for that dialog box (Figure 21).
- Choose Help > Contents... from the main menu to open the online help home page (Figure 22).

![Figure 21 Help button for dialog box Help]
Navigating the Online Help

There are several ways to find the information you need.

- Use the **Search** tab to search for a word or phrase. Use quotation marks to search for an exact phrase, such as “add waveform”.
- Use the **Contents** tab to browse topics in the help system by clicking topics in the left pane.
- Use the **Index** tab to type in a keyword and search the index for that keyword, or scroll through the alphabetical list to find a topic.
- Use the **Favorites** tab to add preferred help topics to a list for easy reference.

For more details on using online help, click **How to Use This Help** under the **Help and More Information** topic in the **Contents** tab.
Using the Demo Wizard

Your Z-Series oscilloscope comes with a built-in demo wizard that showcases many Infiniium features. To see the demos, click Help > Show Demo Wizard.... You can then select a specific demo, such as one for a particular protocol or one for a user interface showing bookmarks.

For example, the following screen display shows the initial demo page for the FFT function. To experiment with the demo, click Load Demo....

![Figure 23 FFT demo](image.png)
A For 2-Channel Models

2-channel models 58
Front panel differences 58
Dialog box differences 58
Main menu selections showing only channels 1 and 2 59
Application software differences 59

The descriptions and examples throughout this manual and in the oscilloscope’s online Help assume you are using a standard, 4-channel Z-Series oscilloscope. However, some Z-Series models use only two channels. This appendix describes the differences unique to the 2-channel models.
2-channel models

- DSOZ632A
- DSAZ632A
- DSOZ592A
- DSAZ592A

You can upgrade any of these models to four channels by purchasing the N2128A channel upgrade product. The upgrade is customer-installable.

Front panel differences

- The channel 3 and channel 4 keys are covered by a keypad cover:

![Keypad Cover](channel-3-4-keys-disabled.png)

- The vertical scaling and vertical offset knobs for channels 3 and 4 are disabled. If pushed or turned, an error message appears:

> Acquisition is not possible on Channel N. Channels 3, 4, and 3R are available with upgrade model N2128A.

Dialog box differences

These dialog boxes contain controls, tabs, or other selections for only channels 1 and 2, not 3 or 4:

- Channel dialog box (also no differential channels)
- Probe Configuration dialog box
- Probe Calibration dialog box
- Bandwidth Limit dialog box
- Trigger Thresholds dialog box
- Calibration dialog box
- Trigger dialog box (including Pattern/State selection and AND Qualifier)
- Add Waveforms dialog box
For example, the Channel dialog box looks similar to this:

![Channel dialog box](image)

Main menu selections showing only channels 1 and 2

- File > Save > To Waveform Memory > To Memory N > Channel N
- Math > New FFT > on Channel N
- Setup > Channel N...

Application software differences

- InfiniiSim does not support 4-port differential mode.
- PrecisionProbe and PrecisionCable are not supported on 2-channel models.
- Some protocol decodes are not supported.
- No compliance applications are supported.
waveform features
  measurements on, 48
waveforms
  acquiring, 40
  associating with measurement results, 48
  drag-and-drop measurements on, 48
  making quick measurements, 48
  measuring using markers, 49
  turning off, 44
window
  zoom, 42
Windows operating system settings, 26

Z

  zoom display, 42
  Zoom key, 42